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A newer version of this document may be available on the web here.

About this document

Scope and purpose

ModusToolbox™ Programmer is a stand-alone, cross-platform, flash programmer tool that provides a graphical
user interface to Program, Erase, Verify, and Read the flash of the target device. It is delivered with the
ModusToolbox™ Programming tools package, and it supports HEX, SREC, ELF, HCD and BIN programming file
formats.

Intended audience

This document helps you learn how to use the ModusToolbox™ Programmer GUI to perform various operations
on devices.

Reference documents

Refer to the Infineon programming solutions website for more information as needed.

Document conventions

Convention Explanation

Bold Emphasizes heading levels, column headings, menus and sub-menus
Italics Denotes file names and paths.

Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder names,

Courier New . . S .
directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item

Abbreviations and definitions

The following define the abbreviations and terms used in this document:

Term Description

CMSIS Arm® Cortex® Microcontroller Software Interface Standard.

CMSIS-DAP CMSIS Debug Access Port.

Open0CD The Open On-Chip Debugger is the debugger tool that provides on-chip programming support.

This tool acts as a backend of the ModusToolbox™ Programmer application.

Data File The data file for programming in the hex or binary format

The Debug Port register of the Arm Cortex CPU. Used for programming and debugging, along

DP . . . .
with the corresponding SWD-address bit selections.

The firmware file loaded into the MCU's RAM. Sometimes referred to as RAM program, Flash

Flash kernel/loader kernel, Flash loader.
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GDB GNU Project Debugger - GNU.org.
Joint Test Action Group. Specifies the use of a dedicated debug port while implementing a serial

JTAG communication interface for low-overhead access without requiring direct external access to
the system address and data buses.

MCU Microcontroller Unit.

PSOC™ A family of microcontroller integrated circuits. These chips include a CPU core and mixed-signal
arrays of configurable integrated analog and digital peripherals.

Region Logical areas within the target device the programmer operates on.

SWD Serial Wire Debug interface.

QSPI Quad Serial Peripheral Interface. A name used for SPI external memory interfaces
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1 Overview

ModusToolbox™ Programmer supports the following features:

e Programming Infineon MCUs' internal and external memories
e PSoC™6 MCUs, including corresponding starter kits and evaluation boards
e PSoC™4 MCUs, including corresponding starter kits and evaluation boards
e PMG1, PAG2S and WLC1 MCUs, including corresponding evaluation boards
e EZ-PD™CCG7S and CCG7D MCUs, CCG4, CCG3PA, CCG6, CCG8
e XMC7100/7200, CYT4BB/BF, CYT2Bx, CYT3Bx

o AIROC™ Wi-Fi/Bluetooth® platforms (CYW4390x, CYW4343W, CYW20829, CYW208xx, CYW55513 and others),
including corresponding starter kits and evaluation boards

e Connectivity devices via support of development boards

e Windows, Linux, and macOS

e Programming external memory devices using PSoC™ 6 external memory interfaces (EBI / QSPI)
e Programming external memory of AIROC™ Wi-Fi devices

e KitProg3 and MiniProg4 hardware

e SEGGER J-Link Base and J-Link Ultra hardware

e OpenOCD via machine interface (MI) to 3rd party debug hardware

e Cross-platform CyBridge library - I°C, SPI, UART communications and USB devices detection

e KitProg3 firmware update
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Installing ModusToolbox™ Programmer

2 Installing ModusToolbox™ Programmer

ModusToolbox™ Programmer is delivered as part of the ModusToolbox™ Programming tools package. A link is
available to download/install from the IDC webpage here:

https://softwaretools.infineon.com/tools/com.ifx.tb.tool.modustoolboxprogtools

For installation details, see section 2 of the ModusToolbox™ Programming tools release notes.
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3 Getting started

3.1

Run ModusToolbox™ Programmer

To run the ModusToolbox™ Programmer GUI application, navigate to the ModusToolbox™ Programming tools
install location, open the mtb-programmer folder, and run the executable. The GUI opens and looks similar to

this:

ModusToolbox™ Programmer

File  View Options Help

Programmer | No programmer found

» &

2 @

Board
Open Power Connect Erase Program Read Verify
Device
Settings X
Program Settings
File (]
Reset Chip

Probe Settings

Log
Info : [CyBridge] Start the API initialization
Info : [CyBridge] The hardware initialization has completed in 58@ ms

Please attach USB probe device to proceed

Not Connected

In this case, no kit or device is connected, and a message displays asking you to connect a device.

3.2 Select device

1. Connect the device to the host computer. Select the hardware programmer in the Programmer drop-

down.

MedusToolbox™ Programmer

File View Options Help

Programmer | Select programmer ~

=]
MNone

KitProg3 CMSIS-DAP BULK-201208B203068400

Board

Open

Device

Settings

Power  Connect

) @B 2 @
Erase Program Read Verify

2. Select the kit name in the Board drop down.

MedusToolbox™ Programmer

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400 ~

= |

Board | CYBCKIT-062-BLE ~ |

Open
Device | CY8C6347BZI-BLD33

© O

Power  Connect

» B 8 @

Erase Program Read Verify
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ModusToolbox™ Programmer displays information under Probe Settings.

ModusToolbox™ Programmer — O x

File View Options Help

Programmer  KitProg3 CMSIS-DAP BULK-2012088203068400 ~

.
Board | CYSCKIT-062-BLE ~] © O N @ 2 @

Open

Power  Connect Erase Program Read Verify
Device (CYBC6347BZI-BLDS53
Settings x
Program Settings
File ()
Reset Chip
Verify Regions
External Memory [l
Program Security Data O
Probe Settings
Interface SWD
Clock (KHz) 2000 ~
Voltage (V) 2.5 ~
Reset Type Soft ~
Sflash Restrictions Erase/Program Sflash prohibited ™
Log
Info : [CyBridge] Start the API initialization
Info : [CyBridge] The hardware initialization has completed in 5@3 ms
Info : Connected - KitProg3 CMSIS-DAP BULK-201208B283068400 FW Version 2.6@.1443
Info : Selected Programmer: KitProg3 CMSIS-DAP BULK-291208B2030634080
Info : Selected Board: CYBCKIT-062-BLE

Press F1 for help _ Not Connected

3.3 Load programming file
1. Click Open.

ModusToolbox™ Programmer

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400 ~

-
Board | CYSBCKIT-062-BLE ~ | O O '] ] = j

Open Power  Connect Erase Program Read Verify
Device (CY8C6347BZI1-BLD53

=}
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2. Onthe Open Programming File dialog, navigate to the location of the HEX, SREC, ELF, or BIN file to load,

select it, and click Open.

Open Programming File
« v T

Organize ~ Mew folder
%9 Windows (C)
artifacts
backup
CMakeFiles
CY8CKIT-062-BLE
cygwint4
DOCS
DRIVERS
ESD
fw-loader
hex

Iread

» ThisPC » Windows (C:) > CY8CKIT-062-BLE

Name

\j BlinkyLED_mainapp_final.elf
1= BlinkyLED_mainapp_final

[] CV8C6347BZI-BLD53_main.bin
\j CY8CH347BZI-BLD53_main.srec

X

v | Q| | Search CY8CKIT-062-BLE P

=- m @

Date modified Type

4/12/2019 5:35 PM ELF File
6/19/2019 2:02 PM HEX File

8/2/2018 2:53 PM BIN File
8/2/2018 2:53 PM SREC File
>

File name: | BlinkyLED_mainapp_final

V‘ Programming Files (*hex *.srec ~

3.4 Connect device

1. Ifthe deviceis not powered, the status message "Not Powered" is displayed in the Status Bar. Click Power

to power up the device.

ModusToolbox™ Programmer

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400

Board | CYSCKIT-062-BLE

v

Open

o

2 @

Probe Settings

Interface SWD
Clock (KHz) 2000
Valtage (V) 3.3
Reset Type Soft

Sflash Restrictions

Erase/Program Sflash prohibited

Power  Connect Erase Program Read Verify
Device | CY8C6347BZI-BLD53

Settings x
Program Settings

File C:/CY8CKIT-062-BLE/BlinkyLED_mainapp_final.hex [1]

Reset Chip

Verify Regions

External Memaory ]

Program Security Data 1

Log

Info : Selected Board: CY8CKIT-862-BLE

Info : [CyBridge] Start the API initialization
Info : [CyBridge] The hardware initialization has completed in 5@7 ms
Info : Connected - MiniProg4 CMSIS-DAP BULK-@7110623@321040@ FW Version
Info : Connected - KitProg3 CMSIS-DAP BULK-201208B203063400
Info : Selected Programmer: KitProg3 CMSIS-DAP BULK-201208B2030638400

FW Version

2.60.1443
2.60.1443

Press F1 for help
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2. Click Connect. ModusToolbox™ Programmer communicates with the device and displays various messages
in the Log. Then, a message in the Status Bar indicates that it is connected.

ModusToolbox™ Programmer — O X
File View Options Help
Programmer KitProg3 CMSIS-DAP BULK-201208B203068400
» —
» 3 «©
Board | CYBCKIT-062-BLE @ éj cﬁ — 2
Open Power Disconnect Erase Program Read
Device CY8C6347BZI-BLD53
Settings x
Program Settings
File C/CY8CKIT-062-BLE/BlinkyLED_mainapp_final.hex ()
Reset Chip
Verify Regions
External Memory
Program Security Data
Probe Settings
nterface SWD
Clock (KHz) 2000
Voltage (V) 33
Reset Type Soft
Sflash Restrictions Erase/Program Sflash prohibited
Log
Info : #4 : psoc6_main_cmd (virtual) at @xl , size @ , buswidth @, chipwidth @ ~
Info : #5 : psoc6_work_cmd (virtual) at @x14000000, size Ox00000@@8, buswidth @, chipwidth @
Info : #6 : psoc6_super_cmd (virtual) at @x16000000, size 0x@000000@, buswidth @, chipwidth @
Info : #7 : psoc6_efuse_cmd (virtual) at @x90700000, size Ox2000240@, buswidth 1, chipwidth 1
Info : Flash banks detected
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected device PN: CY8C6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 1@e DIE:
PSoCBABLE2 v

Connected to the target device

user guide
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3.5 Program device

Click Program. ModusToolbox™ Programmer downloads the program file onto the device and displays
messages in the Log.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer KitProg3 CMSIS-DAP BULK-201208B203068400 -

y R A S ;]
Board CY8CKIT-062-BLE - @ CB = 03
Open Power Disconnect Erase Program Read Verify

Device (CY8C6347BZI-BLD53

Settings x
Program Settings
File C:/CYBCKIT-062-BLE/BlinkyLED_mainapp_final.hex [1]
Reset Chip

> Verify Regions
External Memory

Program Security Data

Probe Settings

Interface SWD
Clock (KHz) 2000 .
Voltage (V) 33 ~
Reset Type Soft ~
Sflash Restrictions Erase/Program Sflash prohibited N
Log
Info : [180%] [ ] [ Erasing 1 ~
Info : [18e%] [ 1 [ Programming ]

Info : wrote 45568 bytes from file C:/CY8CKIT-062-BLE/BlinkyLED mainapp_final.hex in ©.942692s (47.285 KiB/s)
Info : ** Programming Finished **

Info : cyp status: OK

Info : cyp_get_mpn

Info : ** Detected device PN: CY8C6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 1@ DIE: PSoCAABLEZ2
Info : reset run

Info : SWD DPIDR @x6ba@2477

3.6 Save log file
Right-click in the Log section and select Save As.
Log
Info : [1@0%] [ ] [ Erasing 1 A
Info : [1@8%] [ 1 [ Programming ]
Info : wrote 45568 bytes from file C:/CYS8CKIT-862-BLE/BlinkyLED_mair Copy Ctrl+C s (47.205 KiB/s)
Info : ** Programming Finished **
Info : cyp status: OK Select All Ctrl+A
Info : cyp_get_mpn Save As
Info : ** Detected device PN: CYBCB347BZI-BLD53 SiliconID: E287 Revi Clear IE: PSoCBABLE2
Info : reset run
Info : SWD DPIDR @x6ba@2477 -
Note: You can also select the Select All command to select the text, then copy and paste the text to the
file you selected.
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4 GUI description

ModusToolbox™ Programmer contains menus and toolbar commands to perform actions. This chapter
describes the various GUI elements.

ModusToolbox™ Programmer - O s

File View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-0711062303210400

(=N
9 ‘:‘5 <« 2
Board | Custom @ 'j 3 — ﬂj
Open Power Disconnect Erase Program Read Verify
Device | CYBC624ABZI-S2D44
Settings x
Program Settings
File C/CYBCPROTO-062-4343) 624ABZ1-52D44_BlinkFull.hex (]
Reset Chip
Verify Regions
External Memaory
Program Security Data
Probe Settings
Interface ITAG
v JTAG Chain (&3
Z1-52D44
2000
S
Soft
Log
Info : [1@@%] [ 1 [ Erasing 1 -
Info : [1e@%] [ 1 [ Programming ]
Info : wrote 45856 bytes from file C:/CYS8CPROTO-©62-4343W/CY8C624AB7I-52D44/CY8C624AB7I-52D044 BlinkFull.hex
in 3.192891s (13.781 KiB/s)
Info : ** Programming Finished **
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected device PMN: CYBC624ABZI-52D44 SiliconID: E453 Revision: 12 FamilyID: 1682 DIE: PSoC6AZM
Info : reset run @

Device pregrammed successfully Powered: 3303 mV Connected
4.1 Menus
4.1.1 File

The File menu contains the following commands:

e Open (Ctrl+0) - Opens the programming file.

e Connect/Disconnect (Alt+Q) - Connects and disconnects the selected device.
e Program (Alt+G) - Programs the selected device with the selected file.

e Erase (Alt+E) - Erases the selected device.

o Read (Alt+R) - Reads flash of the selected device into a HEX or SREC file.

o Verify (Alt+Y) - Verifies that the selected device is programmed correctly.

e Recent Files - Lists up to five recently loaded programming files.

e Exit (Alt+F4) - Closes the ModusToolbox™ Programmer application.

4.1.2 View

The View menu contains the Settings check box. Select it to view the Settings section of the window; unselect
it to hide the Settings section. See Settings.
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4.1.3 Options

The Options menu contains the following commands:

4.1.3.1 Programmer Options (Alt+T)

Opens the Programmer Options dialog to set the Upgrade Firmware mode and other options.

Programmer Options - ModusToolbox™ Programmer X
Name Value
Upgrade Firmware Show Pop-Up e
OpenQCD Telnet Port ‘4445 ‘

e Upgrade Firmware mode:
o Automatically - The firmware is updated automatically when the tool opens.
e Show Pop-up - A dialog displays asking if you want to upgrade the firmware.
e Ignore - The firmware is not updated and no prompt displays.

e OpenOCD Telnet Port: This option specifies the port number of the OpenOCD telnet connection.

4.1.3.2 Upgrade Firmware (Alt+U)

When this command is enabled, select it to upgrade the programmer firmware on the device.

4.1.4 Verify Regions
The Verify Regions menu is available only if Verify Regions option is selected in Program Settings.
e Add Region - Adds a custom flash region to the Verify Regions list.

o Reload Regions - Resets the Verify Regions list to the default state corresponding to the flash map of the
target.

e Undo (Ctrl+Z) - Undo the last change in the Verify Regions list.
e Redo (Ctrl+Y) - Redo the last change in the Verify Regions list.

o Verify - Initiates the Verify device operation.

4.1.5 Help
The Help menu contains the following commands:

e View Help (F1) - Opens this document.

o About ModusToolbox™ Programmer - Opens the About box.
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4.2 Toolbar

The toolbar contains the Open, Connect, Erase, Program, Read, and Verify commands, which are also
located on the File menu. This area also contains the following:

4.2.1 Programmer, Board, and Device

Use these pull-down menus to select the specific device to use.

4.2.1.1 Programmer

This displays a list of all currently connected probes with a serial number or other identifier (for example, COM
port number) from which you can select the desired Programmer.

ModusToolbox™ Programmer

File View Options Help

Programmer

KitProg3 CMSIS-DAP BULK-201208B203068400 -

Board
Open
Device

None O O ’j

MiniProgd CMSIS-DAP BULK-0711062303210400 BoE

KitProg3 CMSIS-DAP BULK-201208B203068400

Connect

B

Erase Program

=
=

Read

)

Verify

KitProg3 CMSIS-DAP BULK-180715C200020400
Settings x

Program Settings
File C:/CY8CKIT-062-BLE/BlinkyLED_mainapp_final.hex D

4.2.1.2 Board

The Board pull-down allows you to choose the appropriate Kit name for the selected Programmer.

e Underthe Scanned Boards entry, there is a short list of best matched Kit names detected by the tool.
e Under the Others entry, there is a list of all other Kit names available for the selected programmer device.

e When selecting the Custom board, the tool allows you to manually specify the particular target device
connected to a stand-alone programmer (such as MiniProg4) or a KitProg3 with modifiable MCU module.
Custom board is only available for KitProg3, MiniProg4 and JLink programmers.

ModusToolbox™ Programmer — O X
File View Options Help
Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400 -
el £ (=Y
Board | Custom ‘V O O j ] = 1
Open Cust ~ Power  Connect Erase Program Read \Verify
Device | -UStOM
Scanned Boards
Settings CYBCKIT-062-BLE x
- CYBCKIT-062-WiFi-BT
Program Settings CYW943012P6EVE-01
File Others Lhex D
Reset Chip CY7110
Verify Regions oY
Programming Mode| CY7112 -
CY7113 v
Probe Settings
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4.2.1.3

Device

This displays a list of all supported target devices. It is enabled only if you select Custom for the Board option.

File View Options

ModusToolbox™ Programmer

Help

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400

~

\OO??J

m} x

2 O

Board | Custom ™
Open Power  Connect Erase Program Read Verify
Device | CY7C65219-40LQXIT \v
CYTC65219-40LQXIT ~
Settings CYBCA024AXI-5402 bl
Program Settings CY8CA024AXI-5412
File CYBCA024A71-5403 Lhex [::]
; CY8CA024AZ1-5413
Reset Chip
Verify Reions CYBCA024AZQ-5413
T CY8CA024FNI-5402
Programming Mode| g 10540015412 it
Probe Settings CY8CA024LQA-5411
CYBCA024LQA-5413 v
Interface
.
4,2.1.4 Auto-completion

Board and Device pull-downs support auto-completion.

Start typing the name of the Kit in the Board pull-down and the tool will suggest corresponding board names.

File View Options

Programmer
Board

Open
Device

Settings

ModusToolbox™ Programmer

Help

KitProg3 CMSIS-DAP BULK-2012088203068400 ~

062-|

e

CY3CKIT-062-BLE
CYBCKIT-062-WiFi-BT
CYBCPROTO-062-4343W

(O] ¥y B

Power Connect Erase Program Read Verify

= O X

2 9

Start typing the device’s part number in the Device pull-down and the tool will suggest corresponding target

devices.

File View Options

Open
Device

Settings

ModusToolbox™ Programmer

Help

Programmer | KitProg3 CMSIS-DAP BULK-061B12C800287400 -~

Board ‘ Custom

w

Cvsce?|

Program Settings
File
Reset Chip

Verify Regions

CYBCH244A71-54D12
CYBC6244AZ1-54D62
CY8C6244AZ1-54D82
CYB8C6244AZ1-54D83
CYB8C6244AZ1-54D92
CYB8C6244AZ1-54D93
CYB8C6244AZ0-54092

» @B

Power  Connect Erase Program

2 @

Read Verify

Programming Mod

ample-psoc6-hello-world.hex

4.2.2

Use the Power

4.2.3

Power
O

Connect

button to power on and off the selected device.

Use the Connect O button to connect to and disconnect from the selected device.
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4.2.4 Settings

The Settings section of the tool allows you to update the program and probe/target settings as follows:

4.2.4.1 Program Settings

o File - Use this to select the programming file to perform actions on or with.

o Offset - This is an optional offset parameter; it can be an integer or hexadecimal value. The relocation
offset is added to the base address for each section in the image when the image is programmed. This
option is visible only if a binary or elf file is selected for programming operations.

e Reset Chip - Use this to reset the chip after the Program operation completes. This option resets the target
chip and runs the programmed firmware on it.

e Verify Regions - Use this option to define flash regions used during device verification. This allows to verify
user defined flash regions of the PSoC™ MCU. This option does not change behavior of the Program
operation. See Verify Custom Flash Regions of PSoC™ 6 MCU for details.

e External Memory - Enables/disables the programming of external memory in the target device. For PSoC™
6x MCUs, this option enables programming of the QSPI regions. This is also used for programming external
memory of AIROC™ Wi-Fi devices.

e Program Security Data - Allows programming security regions if the target device supports this capability.
For example, for PSoC™ 61 PSoC™ 62, and PSoC™ 63 MCUs, this option enables programming the eFuse
region.

e Target AP - Allows you to select the target access port (DAP) that will be used for programming. Possible
values include: CM0, CM4, and SYS_AP. This option is available only for PSoC™ 64 MCUs.

e Flash Size Limit - Limits the size of application flash available for programming operations. This option is
available only for PSoC™ 64 MCUs.

¢ Programming Mode - Use this option to define programming mode for PMG1 devices. The mode options
include:

e Reset: This programming mode enables acquisition of the target device in the Test mode.
e PowerCycle: In this mode, the programmer cycles power to acquire the device.

e Flashloader - Use this option to select the patched QSPI CMSIS flashloader file (in FLM format). This
flashloader is used for external flash programming.

Note: To be able to program custom external flash you should also provide the appropriate QSPI
configuration file (qspi_config.cfg), generated by the ModusToolbox™ QSPI Configurator tool. This
file should be located in the same directory as the patched flashloader file.

o Debug Certificate - Use this option to specify the location of the debug certificate binary file. The debug
certificate is used for programming AIROC™ CYW20829 targets in Secure lifecycle mode.

e ECC Config - Use this option to enable or disable the ECC error reporting. This option is only applicable for
read flash operations of some MCUs.
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4.2.4.2 Probe Settings

The Probe settings allow you to configure the programming and target device before you connect to it. These
settings are available when ModusToolbox™ Programmer is not connected to the device.

o Interface - To select the hardware (debug) interface for communication with the target device. The
possible values include: SWD and JTAG if supported by the device.

o JTAG Chain - To select the interested target device in the JTAG chain. This option is only available for
probes supporting JTAG interface. See Program PSoC™ 6 MCU in JTAG Chain for details.

e Voltage (V) -To select the power supply voltage of the target device in Volts. This option is available only if
the selected probe has the power control capability.

e Clock (KHz) - To select the frequency of the hardware interface in KHz. This option is available only if the
selected probe supports configurable frequencies.

o Reset Type - Specifies the type of the Reset Chip operation. The possible values include: Soft and XRES:
e Softis a software reset type that sends the system reset request to the ARM core.
o XRESis a hardware reset type that toggles the XRES hardware line.

o Sflash Restrictions - Specifies the Sflash programming behavior. This option is available only for PSoC™
61/62/63, XMCT7100/7200, FX3G2, CYT4Bx and CYT2Bx MCUs. The possible values include:

e Erase/Program of Sflash is prohibited.
e Erase and Program of USER/TOC/KEY is allowed.
e Erase of USER/TOC/KEY and Program of USER/TOC/KEY/NAR is allowed.

e Erase and Program of entire Sflash is allowed.
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5 Programming Operations

This chapter covers the various programming operations you can perform using the ModusToolbox™
Programmer tool.

5.1 Erase Device

1. Connectto the device (see Connect Device).

2. Click the Erase button.

ModusToolbox™ Programmer erases the device and displays various messages in the Log. Then, a message in
the Status Bar indicates that the device was erased successfully or that an error occurred.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer KitProg3 CMSIS-DAP BULK-2012088203068400

[

> }: ©» z|

Board | CYBCKIT-062 BLE (&) < B 2 @

Open FPower Disconnect | Erase |Program Read Verify

Device | CY8C6347BZI-BLD53

Settings b3

Program Settings

3

File C:/CYBCKIT-062-BLE/BlinkyLED_mainapp_final.hex
Reset Chip

Verify Regions

External Memory

Program Secunity Data

Probe Settings
nterface SWD
Clock (KHz) 2000
Voltage (V) 3.3
Reset Type Soft
Sflash Restrictions Erase/Program Sflash prohibited
Log
Info : [180%] [ ] [ Erasing ] ~

Info : erased sectors @ through 63 on flash bank 1 in 9.026148s

Info : ** Erasing bank @ **

Info : [1eex] [ 1 [ Erasing 1

Info : erased sectors @ through 2047 on flash bank @ in ©@.152235s

Info : cyp status: OK

Info : ** Erased OK **

Info : cyp_get_mpn

Info : ** Detected device PN: CYBC6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 18@ DIE: PSoCG6ABLE2

Device erased successfully Powered: 3317 mV Connected
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5.2 Program Device
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in Load Programming File section.

3. Connect to the device (see Connect Device).

4. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that device was programmed successfully or that an error occurred.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer  KitProg3 CMSIS-DAP BULK-201208B203068400
—~
vJ : £y 2
Board CYBCKIT-062-BLE @ ‘j {‘.ﬂ = @
Open Power Disconnect Erase | Program | Read Verify

Device (CY8C6347BZI-BLDS3

Settings b

Program Settings
File C:/CY8CKIT-062-BLE/BlinkyLED_mainapp_final.hex [:]
Reset Chip ]
Verify Regions
External Memory

Program Security Data

nterface SWD
Clock (KHz) 2000
Voltage (V) 33
Reset Type Soft
Sflash Restrictions Erase/Program Sflash prohibited
Log
Info : [186%] [ 1 [ Programming ] A
Info : Padding image section 1 at 8x198@b7c4 with 6@ bytes (bank write end alignment)
Info : [186%] [ 1 [ Erasing 1
Info : [180%] [ ] [ Programming ]

Info : wrote 45568 bytes from file C:/CYS8CKIT-062-BLE/BlinkyLED_mainapp_final.hex in ©.946595s (47.011 KiB/s)
Info : ** Programming Finished **

Info : cyp status: OK

Info : cyp_get_mpn

Info : ** Detected device PN: CY8C6347BZI-BLD53 SiliconID: E287 Revision: 23 FamilyID: 18e DIE: PSoCGABLE2 v

Device pregrammed successfully Powered: 3317 mV Connected
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5.3 Program Device and Reset Chip
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load Programming File section.

3. Connect to the device (see Connect Device).

4. Select the Reset Chip check box under Program Settings.
5. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer  KitProg3 CMSIS-DAP BULK-201208B203068400

Board CYBCKIT-062-BLE @ 1'9 {‘.ﬁ g Qj
Open Power Disconnect Erase | Program | Read Verify
Device (CY8C6347BZI-BLDS3
Settings b
Program Settings
File C:/CY8CKIT-062-BLE/BlinkyLED_mainapp_final.hex [:]
[ Reset Chip ]

Verify Regions
External Memory

Program Security Data

Probe Settings
SWD
2000
33
Soft
Sflash Restrictions Erase/Program Sflash prohibited
Log
Info : [186%] [ 1 [ Erasing 1 A
Info : [1e6%] [ 1 [ Programming ]

Info : wrote 45568 bytes from file C:/CYS8CKIT-862-BLE/BlinkyLED_mainapp_final.hex in ©.944648s (47.187 KiB/s)
Info : ** Programming Finished **

Info : cyp status: OK

Info : cyp_get_mpn

Info : ** Detected device PN: CYBC6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 1@e DIE: PSoCGABLEZ
Info : reset run

Info : SWD DPIDR @x6ba@2477

W
Device programmed successfully Powered: 3316 mV Connected
The target device is reset and running.
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5.4 Program Binary File with Offset

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the binary programming file as described in the Load Programming File section.

3. Connect to the device (see Connect Device).

4. Enter the desired address in the Offset field under Program Settings.
5. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

Note: Offset options is available only for binary programming files.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer KitProg3 CMSIS-DAP BULK-201208B203068400

(=N
. J | © ;|
Board | CYBCKIT-062-BLE o N B 2 a
Open Power Disconnect Erase Program Read Verify
Device (CY8C6347BZI-BLD53
Settings X
Program Settings
File C:/CYBCKIT-062-BLE/BlinkyL ED_mainapp_final bin [
((Offset 0x10000000)
Reset Chip

Verify Regions

Probe Se

S!'.'..::
Clock (KHz) 2000
Voltage (V) 33

Soft

Erase/Program Sflash prohibited

Log

Info : [186%] [ 1 [ Programming ] ~
Info : wrote 47184 bytes from file C:/CY8CKIT-062-BLE/BlinkyLED mainapp_final.bin in ©.816682s (56.325 KiB/s)
Info : ** Programming Finished **

Info : cyp status: OK

Info : cyp_get_mpn

Info : ** Detected device PN: CY8C6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 1@e DIE: PSoCG6ABLE2
Info : reset run

Info : SWD DPIDR ©x6ba@2477

Device programmed successfully Powered: 3315 mV/ Connected
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5.5 Program External Memory

1. Attach and select a device that supports external memory (for example, CYS8CKIT-062-WiFi-BT with QSPI
support).

2. Select the External Memory option under Program Settings.

Settings X

Program Settings

File C:/CYBCKIT-062-BLE/BlinkyLED_mainapp_final.hex E]
Reset Chip
Verify Regions
[External Memaory ]
Program Security Data ]

Probe Settings

Interface SWD

Clock {(KHz) 2000 ~

Voltage (V) 33 52

Reset Type Soft i
[Sﬂash Restrictions Erase/Program USER/TOC/KEY allowed ] ~

3. Select the programming file as described in the Load Programming File section. The programming file
should contain external memory region(s) and correct QSPI configuration data.

4. Select Erase/Program USER/TOC/KEY allowed option under Probe Settings > Sflash Restrictions.

5. Connectto the device (see Connect Device).

6. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

Programmer  KitProg3 CMSIS-DAP BULK-201208B202068400

O AlA|g @

Board
Open Power Disconnect Erase |Program | Read Verify
Device
Settings x
Program Settings
File Cy [:]
Reset Chip
Verify Regions
External Memory
Program Security Data
Probe Settings
SWD
2000
33
Soft
Erase/Program USER/TOC/KEY allowed
Log
Info : [1eex] [ 1 [ Erasing 1 A
Info : [1@0%] [ 1 [ Programming ]
Info : wrote 45568 bytes from file C:/CY8CKIT-862-BLE/BlinkyLED_mainapp_final.hex in ©.943738s (47.153 KiB/s)
Info : ** Programming Finished **
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected device PN: CYBC6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 1@e DIE: PSoCGABLE2
Info : reset run
Info : SWD DPIDR @x6ba@2477 @

Device programmed successfully e Connected
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5.6 Program PSoC™ 6 MCU in JTAG Chain

Infineon

1. Connect the host computer to a MiniProg4 or J-Link probe attached to several MCU targets in the JTAG

chain.

The following hardware configuration is used in this example:

MiniFrogd -
T TDO
PS0C 6-512K FEEnill

A AP 11
EDiED ED- £

PS0C 6-1M | psocssizk | [ psoceam | PSoC 6-2M

;b[ TAP 2 H TAP 3 ]—b[ TAP 4 H TAF S ]——’I TAP & H TAPT H TAP & H TAP 8 ]—'

The sample JTAG chain configuration contains six serially-connected PSoC™ 6 MCU targets.

2. Select the MiniProg4 probe and target device in the Programmer, Board, and Device drop-downs, and
ModusToolbox™ Programmer will display information under Probe Settings. Ensure the JTAG chain is

powered.

3. Select the JTAG interface in the Interface drop-down.

ModusToolbox™ Programmer - O X

File  View Options Help
Programmer | MiniProg4 CMSIS-DAP BULK-1D1016CB00086400 ~
~
L Board | Custom ~ ‘ O O j ] = j
Open Power  Connect Erase Program Read Verify
Device | CYBC6245AZ1-S3D72 ™ ‘

Settings x
Program Settings

File C:/hex/psoct/CYBCKIT-062-WIFI-BT/mtb-example-psoc6-hello-world.hex E]

Reset Chip [

Verify Regions

External Memory [l

Program Security Data O
Probe Settings ~

Interface SWD ~

Clock {KHz) SWD

Vaoltage (V) JTAG

Reset Type Soft B

Sflash Restrictions Erase/Program Sflash prohibited i
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ModusToolbox™ Programmer queries the JTAG chain and displays detected devices under the JTAG Chain
option in Probe Settings. The list of devices in the chain contains target names for supported devices and
ID codes for those which are not supported.

ModusToolbox™ Programmer - O x

File View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-1D1016CB00086400 -

Board | Custom ~ | O O j j ; j

Open Power  Connect Erase Program Read Verify
Device | CYBCH24ABZI-S2D44 ~ |

Settings X

Program Settings
File C:/hex/psoct/CYBCPROTO-062-4343W/HelloWorld/mth-example-psoct-hello-world hex E]
Reset Chip
Verify Regions
External Memory [l
Program Security Data O

Probe Settings ~
Interface ITAG ™

v JTAG Chain («2

[0] CYBC6245A71-53D72 ()
[1]1CY8C637BZI-MD76 (O
[2] CY8CE245AZ1-53D72 (O
[31 CYRCARITBRZI-MDTE ()
| [4] CYSC624ABZI-52D44 @
[5] CY8Ce37BZI-MDe O

Clock (KHz) 2000 v
Voltage (V) 33 M

Reset Type Soft ~

4. Select the desired target device in the list by clicking the radio button next to the target name.

5. Select the programming file as described in the Load Programming File section.

6. Click Connect. ModusToolbox™ Programmer communicates with the device and displays various messages
in the Log. Then, a message in the Status Bar indicates that it is connected.

Log
F = = = = ¥ ¥ ] "
Info : #4 : psoc6_main_cmd (virtual) at ©x1000000@, size 9x000 , buswidth @, chipwidth @ ~
Info : #5 : psoc6_work_cmd (virtual) at @x14000000, size Ox00@ , buswidth @, chipwidth @
Info : #6 : psoc6_super_cmd (virtual) at @x16000000, size Ox0@ , buswidth @, chipwidth @

Info : #7 : psoc6_efuse_cmd (virtual) at 8x90700000, size Ox0000040@, buswidth 1, chipwidth 1

Info : Flash banks detected

Info : cyp status: OK

Info : cyp_get_mpn

Info : ** Detected device PN: CYBC624ABZI-S2D44 SiliconID: E453 Rewvision: 12 FamilyID: 182 DIE: PSoCbBA2M

Connected to the target device Powered: 3306 m\V CY8C624ABZI-52D44
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7. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a
message in the Status Bar indicates that the device was programmed successfully or that an error occurred.

ModusToolbox™ Programmer — O X

File View Options Help

Programmer  MiniProg4 CMSIS-DAP BULK-1D1016CB00086400

= —
Board Custom @ @ {a 8 og
Open Power Disconnect Erase Program Read Verify

Device (CY8C624ABZI-S2044

Settings x
Program Settings
File C:/hex/psoc6/CYSCPROTO-062-4343W/HelloWorld/mtb-example-psoct-hello-world.hex [:]
Reset Chip
Verify Regions

External Memory

Program Security Data

Probe Settings

Interface JTAG

v JTAG Chain (&2

[0] CY8C6245A71-S3D72
[1] C¥YBCB37BZI-MD76
[2] CY8C6245AZ1-53D72
[3] CY8C637BZI-MD76
[4] CYBC624ABZI-52D44
[5] CYBC637BZI-MD76

Clock (KHz) 2000
Voltage (V) 3.3
Reset Type Soft
Log
Info : [100X%T [ T T Erasing 1 ~
Info : [100%] [ 1 [ Programming ]
Info : wrote 52224 bytes from file C:/hex/psoc6/CYSCPROTO-862-4343W/HelloWorld/mtb-example-psoc6-hello-
world.hex in 4.628674s (11.918 KiB/s)
Info : ** Programming Finished **
Info : cyp status: OK
Info : cyp_get_mpn
Info : ** Detected dewvice PN: CYBC624ABZI-S2D44 SiliconID: E453 Rewision: 12 FamilyID: 182 DIE: PSoC6A2M
Info : reset run o
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5.7 Verify Device

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load Programming File section.

3. Connect to the device (see Connect Device).

4. Click the Verify button.

ModusToolbox™ Programmer performs the Verify device operation and displays various messages in the Log.
Then, a message in the Status Bar indicates that the device was verified successfully or that an error occurred.

ModusToolbox™ Programmer - O x

File View Options Help

Pragrammer | KitProg3 CMSIS-DAP BULK-201208B203068400

O »H B Bl

Power Disconnect Erase Program Read| Verify

Board C

Open
Device | C

Settings X

Program Settings
File C:/CYBCKIT-062-BLE/BlinkyLED_mainapp_final.hex [:]
Reset Chip
Verify Regions
External Memaory

Program Security Data

nterface SWD

Clock (KHz) 2000

33
Soft
Sflash Restrictions Erase/Program Sflash prohibited
Log
Info : flash ‘psoc6’ found at @x14800086 ~

Info : ** Probing bank 2 **

Info : flash ‘psoc6’ found at @x16800000

Info : ** Probing bank 3 **

Info : flash 'psoct_efuse” found at ©x9@700000

Info : ** Verifying image C:/CY8CKIT-0862-BLE/BlinkyLED_mainapp_final.hex offset:8 **

Info : verified 45144 bytes in ©.179045s (246.228 KiB/s)

Info : cyp status: OK

Info : ** Verified OK **

Info : cyp_get_mpn

Info : ** Detected device PN: CY8CE347BZI-BLD53 SiliconID: E2@7 Revision: 23 FamilyID: 1@@ DIE: PSoCGABLE2

W

Device verified successfully Powered: 3324 mV Connected
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5.8 Verify Device with External Memory

Infineon

1. Connect the device that supports external memory (for example, CY8CKIT-062-WiFi-BT with QSPI support)

to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load Programming File section. The programming file

should have external memory region(s).

3. Select the External Memory option under Program Settings.

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400

Probe Settings

p p —~
Board | CYBCKIT-062-BLE ~ ‘ O O ,] ] = j
Open Power  Connect Erase Program Read Verify
Device | CY8C6347BZI-BLDS53
Settings x
Program Settings
File C:/CYBCKIT-062-BLE/CYBC6347BZI-BLD53_smif SFDP.hex D
Reset Chip
Verify Regions
[External Memaory ]
Program Security Data |

Interface SWD

Clock {KHz) 2000 >
Voltage (V) 33 ™
Reset Type Soft i
Sflash Restrictions Erase/Program Sflash prohibited ~

4. Connect to the device (see Connect Device).

5. Click the Verify button.
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ModusToolbox™ Programmer verifies the device and displays various messages in the Log. Then, a message in
the Status Bar indicates that the device was verified successfully or that an error occurred.

ModusToolbox™ Programmer — O X

File View Options Help

~ Programmer KitProg3 CMSIS-DAP BULK-201208B203068400
~ [
@ g © 5
Board | CYBCKIT-062-BLE A @ = 03
Open Power Disconnect Erase Program Read | Verify
Device (CY8C6347BZI-BLD53

Settings x
Program Settings
File C:/CYBCKIT-062-BLE/CY8C6347BZI-BLD53 _smif_SFDP.hex [1]
Reset Chip

> Verify Regions
External Memory

Program Security Data

Probe Settings

nterface SWD
Clock {(KHz) 2000
Voltage (V) 33
Reset Type Soft
Sflash Restrictions Erase/Program USER/TOC/KEY allowed
Log
e T T TIooTT poULT T GT uRT ~
Info : ** Probing bank 3 **
Info : flash ‘psoc6_efuse’ found at @x90700600
Info : ** Probing bank 8 **
Info : flash ‘cmsis_flash® found at @x18000600
Info : ** Verifying image C:/CY8CKIT-062-BLE/CY8C6347BZI-BLD53_smif_SFDP.hex offset:@ **
Info : verified 62552 bytes in ©.486981s (125.438 KiB/s)
Info : cyp status: OK
Info : ** Verified OK **
Info : cyp _get_mpn
Info : ** Detected device PN: CY8C6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 10@ DIE: PSoC6ABLEZ2 w
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5.9 Verify Custom Flash Regions of PSoC™ 6 MCU

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load Programming File section.

3. Connect to the device (see Connect Device).

4. Expand Verify Regions option in Program Settings to see the list of flash regions available for verification.
By default, only supported by target device regions are displayed:

e application

e AUXflash
e Sflash
e eFuse
e QSPI
Settings X
Program Settings
File C:/CYBCKIT-062-BLE/CY8Ca347BZI-BLD53_smif_SFDP.hex [I]
Reset Chip
~ Verify Regions
From To
0x10000000 Ox100f£££E
0x14000000 0x14007£££
0x16000000 0x16007££E
0x50700000 0xS07003£E
0x18000000 0x18080000
External Memory
Program Security Data

5. Right-click on Verify Regions, or any region entry, to open the context menu.

Settings x
Program Settings
File C:/CYBCKIT-062-BLE/CYBC6347BZI-BLD53_smif_SFDP.hex E
Reset Chip =
~ Verify Regions Add Region
From Reload Regions
0x100000¢ Undo Cirl+Z
0x140000¢( Redo Ctri+Y
0x160000( Verify
0x90700000 0x907003ff

0x18080000

Program Security Data

6. Toadd a custom flash region, select Add Region. Select the added list entry, and enter the correct values
for start and end addresses of the region.

Settings x
Program Settings
File C:/CYBCKIT-062-BLE/CY8C6347BZI-BLD53_smif_SFDP.hex [I]
Reset Chip
~ Verify Regions
From To
0x10000000 Ox100f£EfE
0x14000000 0x14007£££
0x16000000 0x16007££E
0x90700000 0x907003fF
[ 0x10001000 © ox10100000 ]
External Memory
Program Security Data
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7. Toremove any region in the list, right-click the desired region entry and select Remove Region.

Settings x

Program Settings

File C:/CY8CKIT-062-BLE/CYBC6347BZI-BLD53_smif_SFDP.hex E
Reset Chip
~ Verify Regions
From To
0x10000000 Ox100££££E
0x14000000 AetannTEsE
0x16000000 Add Region
0x50700000 [ Remove Region ]
0x10001000 Undo Ctrl+Z
External Memory Redo Ctrl+Y

Program Security Data Verify

Probe Settings Redo Gk
nterface Cut Ctrl+X
Clock (KHz) Copy Ctrl+C
Voltage (V) Paste Ctrl+V
Reset Type Delete

Sflash Restrictions
Select All Ctrl+A

lnn

8. Torevert any previous change, select Undo.

9. When finished with the list of regions, start device verification by clicking the Verify button on the toolbar.

T p nme — O ps
Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400
.
» 3 <« k|
Board CYBCKIT-062-BLE @ ﬁ'_—j cﬂ = Gj
Open Power Disconnect Erase Program Read | Verify
Device (Y8C6347BZI-BLDS53
Settings x
Program Settings
File C:/CYBCKIT-062-BLE/CYBC6347BZI-BLD53_smif_SFDP.hex E
Reset Chip
v Verify Regions
From To
0x10000000 0x100f£££E
0x14000000 0x14007£££
Ol £A000000 Nuwl c0NTFEF
You can also select Verify on the context menu.
Settings x
Program Settings
File C/CYBCKIT-062-BLE/CY8CE347BZI-BLD53_smif_SFDP.hex E
Reset Chip Add Region
~ Verify Regions Reload Regions
From € Undo Ctri+Z
0x10000000 03 Redo Ctrl+Y
0x14000000 0z 5
[ Verify
0x16000000 o
0x%0700000 0x907003££

ModusToolbox™ Programmer verifies only the regions specified in the Verify Regions list. Then, a message
in the Status Bar indicates that the device was verified successfully or that an error occurred.
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10. To reset the Verify Regions list to its default state select Reload Regions from the context menu. This
action will remove all custom regions and load default regions corresponding to the flash map of the
PSoC™ 6 MCU.

Settings X
Program Settings
File C/CY8CKIT-062-BLE/CYBC6347BZI-BLD53_smif_SFDP.hex [I]
. Ees_a ;h'p_ Add Region
erify Regions L Reload Regions
From
Undo Ctrl+Z
Redo Ctrl+Y
Verify
0xS07003£f
.
5.10 Read Device

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Connect to the device (see Connect Device).

3. Click the Read button.

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400

O & B (2|

Power Disconnect Erase Program | Read | Verify

Board C

Open

Device C

Settings x

4. Onthe Read Device to File dialog, navigate to the location of the HEX or SREC file to be saved, enter the file
name, select the file type in the Save as type drop-down, and click Save.

Read Device to File *
«— v T « CYBCKIT-062-BLE *> read ~ O Search reac yel
Organize = New folder g= - 0
= Documents -~ Name . Date modified Type
¥ Downloads
D Musi No items match your search.
usic
&= Pictures
E Videos
& Windows (C)
v < >
File name: v
Save as type: | Programming File (*.hex) A
A Hide Folders Cancel
Note: Under Ubuntu Linux, specify the full file name with an extension (e.g. kp3-dev.srec); otherwise, the

file will be saved in HEX format.

user guide 300f44 002-25230 Rev.*J
2024-04-29



o _.
ModusToolbox™ Programmer GUI user guide | n f| neon

Programming Operations

ModusToolbox™ Programmer performs the Read device operation and displays various messages in the Log.
Then, a message in the Status Bar indicates that the device was read successfully or that an error occurred.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400

O » & 8 @

Board
Open Power Disconnect Erase Program Read Verify
Device
Settings X
Program Settings
File ()
Reset Chip
Verify Regions
External Memory
Program Security Data
SWD
2000
3.3
e Soft
Sl estrictions Erase/Program USER/TOC/KEY allowed
Log
INiU . TANGLT. PSULU.Cpu N
Info : set SMIF_BANKS {1 {addr exl size @x040800 psize @x4623980E esize OxC629AEEGE}}
Info : region 1 addr 9x18000000 size @x@4000000
Info : Detected SMIF region: 0x13060000@, size: 0x04000000
Info : ** Reading bank 8, filename C:/Users/ShevchukOlek/AppData/Local/Temp/dump 8 A82653184.bin **
Info : dumped 67108864 bytes in 519.13855@s (126.24@ KiB/s)
Info : cyp status: OK
Info : Converting read binary files to C:/CYBCKIT-862-BLE/read/read_kp3_dev.hex
Info : ** Read device Finished **
Info : cyp_get_mpn
Info : ** Detected device PN: CY8C6347BZI-BLD53 SiliconID: E207 Revision: 23 FamilyID: 1@@ DIE: PSeCeABLE2
Device read successfully to C:;/CY8CKIT-062-BLE/read/read_kp3_dev.hex Powered: 3316 mV Connected
Note: Read Device feature is not available for the boards based on WICED-Bluetooth hardware
programmers.

5.11 Program eFuse Region of PSoC™ 6/TRAVEO™ T2G/XMC7xxx MCU
1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load Programming File section. The programming file
should contain valid eFuse data region (at address 0x90700000).

3. Select the Program Security Data check box under Program Settings.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-0711062303210400 ~

Board | Custom ~ | O O ’j ] ; ]

Open Power  Connect Erase Program Read Verify
Device | CYBC6347BZ1-BLD53 e |
Settings x
Program Settings
File C:/hex/efuse/efuses. hex [I]
Reset Chip
Venfy Regions
External Memory [
[ Program Security Data ]
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4. Connect to the device (see Connect Device).

5. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

MaodusToolbox™ Programmer — O *
File View Options Help

Programmer | MiniProg4 CMSIS-DAP BULK-11170B2303210400 -

=" S\ (=
Board | CYSCPROTO-06253-4343W > (& »N @D 2@

Open Power Disconnect Erase Program Read Verify
Device | CY8C6245L00-53D72

Settings ®x
Program Settings
File C:/1SS/IWW2413/PSoC6_512k/efuse secure hex (e
Reset Chip

» Verify Regions
External Memory
Program Security Data

Probe Settings

Interface SWD -
Clock (KHz) 2000 i
Voltage (V) 25 -
Reset Type Soft ~
Sflash Restrictions Erase/Program entire 5flash allowed ~

Log
Info : Section start address @x98788158 breaks the required alignment of flash bank psoc6_efuse_cm@ ~

Info : Padding 344 bytes from ©x96788088
Info : Padding image section @ at 8x98788168 with 672 bytes (bank write end alignment)
Info : Erase operation for EFuse bank is not supported, skipping
The target is already in the 'Secure' Life Cycle stage
Info : wrote 1824 bytes from file C:/!55/!WW2413/PSoC6_512k/efuse_secure.hex in 8.831179s (32.873 KiB/s)
Info : ** Programming Finished *#
Info : cyp status: OK
Info : cyp get mpn &

If some eFuse bits have been already programmed before, a warning message "The efuse bit at address xx has
been already blown" appears in Log.

Log
Info : psocb.cpu.cm4 halted due to debug-request, current mode: Thread S
Info : xPSR: ©0x61000000 pc: 0x1600400a msp: 00000000
Info : ** Programming Started **
Info : auto erase enabled
Iofa - Frase tion for FEuse hank is nat sunnarted skinning
The efuse bit at address @x7F[6] has already been blown
The efuse bit at address 0x7F[7] has already been blown
Info : The Life Cycle stage is not present in the programming file
Info : wrote 1024 bytes from file C:/hex/efuse/efuses.hex in 2.112926s (©.473 KiB/s)
Info : ** Programming Finished **
Info : cyp status: 0K
Info : cyp_get_mpn
Info : ** Detected device PN: (Y8(6347BZI-BLDS3 SiliconID: E207 Revision: 22 FamilyID: 100 DIE:

PSoC6ABLE2
Info : reset run
Info : SWD DPIDR @x6ba02477 v
[Powered: 2503mVl Cvscs3478z1-BLDS3
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5.12 Program PSoC™ 4 MCU With Protected Flash

Flash protection allows you to protect any PSoC™ 4 flash rows from being written. Applying protection to the
user data with ModusToolbox™ Programmer is nothing more than programming a data file containing
appropriate flash protection region (at the address 0x90400000).

Programming data into protected flash region disabled.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-0D1D07B303105400

—~
» = «» A
Board | CYSCKIT-041-41XX @ f’] “:ﬂ e Oj
Open Power Disconnect Erase Program Read Verify

Device | CYBC4146AZ1-5433

Settings x
Program Settings
File C:/hex/psocd/042_not_flprotected.hex [I]
Reset Chip

Verify Regions

Probe Settings

nterface SWD
Clock {(KHz) 2000
Reset Type Soft
Log
Info : ** Device acquired successfully ~

Info : ** Programming Started **
Info : auto erase enabled
Only mass erase available, erase skipped! (psoc4 mass_erase)
Info : [ 10%] [### 1 [ Programming ]
Error: [ 13%] [#### ] [ Programming ]Error: Flash algorithm reported failure - "Row
Protected - The row id provided is a protected row"
Error: error writing to flash at address @x@0000000 at offset Ox00000000
Error: cyp status: ERROR
Info : Program device failed
Error: C:/Infineon/Tools/ModusToolboxProgtools-1.1/mtb-programmer/./scripts/cyp_base_default.tcl:38: Error: **
Programming Failed **
Error: in procedure 'program_device'
Error: at file "C:/Infineon/Tools/ModusToolboxProgtools-1.1/mtb-programmer/./scripts/cyp_base_default.tcl”,
line 38
Info : cyp_get_mpn

Error: Program device failed _ Connected

Use the Erase button to un-protect user flash rows from writing.
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5.13 Program Chip-Protected PSoC™ 4 MCU

The chip-level protection mechanism restricts access of the programmer application to silicon resources. In
this mode, access to flash, SRAM, and most of the registers in the PSoC™ 4 are disabled. Chip protection can be
activated by programming a HEX file with a special protection region at address 0x90600000.

If you try to connect ModusToolbox™ Programmer to a chip-protected PSoC™ 4/PMG1/WLC1 device, a warning
message indicates that device is in protected mode. The only available operation is Erase device in this case.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-0D1D07B303105400

T-041-41XX ) A L 8 @

Board C
Open Power Disconnect| Erase Program Read Verify
Device | CYSC
Settings x
Program Settings
File C:/hex/psoc4/41005/CE216873 ADC with Breathing LED_lock.hex E]
Reset Chip
Verify Regions
Probe Settings
. SWD
Clock (KHz) 2000
Reset Type Soft
Log
Info : gdb port disabled ~

Info : accepting 'telnet’' connection on tcp/4445

Info : Open On-Chip Debugger

Info : init_target

Info : Deferring arp_examine of psocd.cpu

Info : Use arp_examine command to examine it manually!

Info : kitprog3: acquiring the device (mode: reset)...

Info : **Failed to acquire PSoC 4 device in Test Mode

Info : cyp status: OK
o ok o ok ke K ke R R R R R R Rk Rk kR R ok kR Rk kR Rk kR Rk kR kR Rk kR kK
* PSoC 4 device is in PROTECTED mede.
* Press Erase Device to clear protection. All data will be lost!
3k 0 308 5K B 0K R 80 8 K 8 0 e B Ok Rk i ok ok Rk e ik R R kR kK

Info : reset run

Info : Deferring arp_examine of psocd.cpu

Info : Use arp_examine command to examine it manually!

Device programmed successfully Powered: 3373 mV CYBC4146AZ1-5433

Use the Erase button to clear chip protection and move target to the open state.
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5.14 Program Secure AIROC™ CYW20829 MCU

You can program the flash of an AIROC™ CYW20829 device in Secure lifecycle mode only by providing a valid
debug certificate file.

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load Programming File section.

3. Click on the Debug Certificate option under Program Settings and select the certificate file in the dialog.

The path will display under Settings.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer | KitProg3 CMSIS-DAP BULK-0D1D07B303105400 ~

Board | CYW920829M2EVB-01 ~ ‘ \—) I\) ’] j = 11

Open Power  Connect Erase Program Read Verify
Device | CYW20829A0LKML

Settings X

Program Settings

File C:/hex/CYW20829A0LKML/CYW20829A0LKML secure_no_cm33_app.hex I:I
Reset Chip

Verify Regions

Flashloader Default R |:|
Debug Certificate C:/hex/CYW20829A0LKML/debug_cert_oem.bin » |:|

Probe Settings

Interface SWD
Clock (KHz) 2000
Reset Type Soft

4. Connectto the device (see Connect Device).

5. Click the Program button.

5.15 Program QSPI memory with patched flashloader

This feature is supported by AIROC™ CYW20829 devices, as well as XMC7100/7200 and CYT4Bx MCUs. It allows
you to specify the patched flashloader file in FLM format along with the appropriate QSPI configuration.
Patched flashloaders contain data about how your external memory is configured.

1. Connect the device to the host computer and select it in the Programmer, Board, and Device drop-downs.

2. Select the programming file as described in the Load Programming File section.

3. Select the External Memory option under Program Settings (if supported).

4. Click on the Flashloader option under Program Settings and select the patched flashloader (FLM) file in
the dialog.
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The path will display under Settings.

ModusToolbox™ Programmer - O X
File View Options Help
Programmer  KitProg3 CMSIS-DAP BULK-0D1D07B303105400 ~ _ ) —
Board | CYW920829M2EVB-01 ~ | O O /] 1 = —j
Open Power  Connect Erase Program Read Verify
Device CYW20829A0LKML
Settings X
Program Settings
File C:/hex/CYW20829A0LKML/CYW20829A0LKML_secure_no_cm33_app.hex [I]
Reset Chip
Flashloader |C:/hex/CYWZDBEQADLKML/FLM;"CYWZOS)(){_SMIFFLM w7 | [I]
Debug Certnicate None v | L
Probe Settings
Interface SWD
Clock {KHz) 2000 ~
Reset Type Soft V)
5. Connect to the device (see Connect Device).
6. Click the Program button.
Note: To be able to program custom QSPI memory, you should also provide the appropriate QSPI

configuration file (qspi_config.cfg) generated by the ModusToolbox™ QSPI Configurator tool. This
file should be placed in the same directory as the patched flashloader file; it is located and read by
ModusToolbox™ Programmer automatically.

Refer to the QSPI Configurator user guide for more information about patching flashloaders.

5.16 Program AIROC™ CYW955513EVK-01 and CYW9M2BASE-43012BT boards

1. Connect the device to the host computer and perform recover device procedure as described in section 6.2.

2. Click the Programmer pull-down and select '"WICED Bluetooth-PortXX' programmer.

ModusToolbox™ Programmer

File View QOptions Help

Programmer |KitProg3 CMSIS-DAP BULK-14060A5102122400 ~
p
Board Nane O ’] j
Open KitProg3 CMSIS-DAP BULK-14060A5102122400 Power Connect Frase Program
Device | WICED Bluetooth-COM?29

Note: The CYWIM2BASE-43012BT board should be switched to Dual UART mode first, otherwise the
WICED Bluetooth programmer will be unavailable in the Board pull-down menu. To do this, press
the hardware 'Mode' button on the Kit, hold it for 3 seconds, then release it.
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3. Openthe Board pull-down and select the appropriate board name (e.g. CYW955513EVK-01)

4. Select the programming file as described in the Load Programming File section.

5. Connectto the device (see Connect Device).

6. Click the Program button.

ModusToolbox™ Programmer programs the device and displays various messages in the Log. Then, a message
in the Status Bar indicates that the device was programmed successfully or that an error occurred.

Programmer |WICED Bluetooth-COM29

e » &

—~
Board  CYW355513EVK-01 = ]
Open Power Disconnect = Erase Program Read Verify
Device CYW55513IUBG
Settings x
Program Settings
File C:/hex/wiced-bt/Hatchet1/mtb-example-threadx-empty-app_download.hex E]
Reset Chip

UART
None
Log
Info : Detecting COM port ... ~
Info : COM3 UNKMOWNTYPE  UNKNOWNID
Info : COM29 HCI  UNKNOWNID 115200

Info : Device detected SUCCESSFULLY

Info : HCI port : COM29

Info : HCI speed: 11528@

Info : Downloading FW ...

Info : Chipload.exe -BLUETOOLMODE -PORT COM29 -BAUDRATE 11528@ -BTP "C:/Infineon/Tools/
ModusToolboxProgtools-1.1/mtb-programmer/BT/CYW955513EVK_@1/CYWI555x.btp” -NOERASE -CONFIG “"C:/hex/wiced-
bt/Hatchetl/mth-example-threadx-empty-app_download.hex™ -DL_TIMEOUT MULTIPLIER 2

Info : Done

Info : cyp status: OK

Info : ** Programming Finished **

Info : cyp_get_mpn

Info : reset run

Device programmed successfully e Connected
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6 Troubleshooting

6.1 Limitations

e ModusToolbox™ Programmer does not support RAM programming, you can program only the flash memory
of a target device, except for devices that support only RAM such as CYW9M2BASE-43012BT and
CYW955513EVK-01 kits.

e Programming devices in DAPLink mode is not supported. You have to switch your device into CMSIS-DAP
BULK mode by pressing the mode selection button.

6.2 How to Recover AIROC™ Bluetooth® Devices on Failure

If the program operation for an AIROC™ Bluetooth® device fails, it is possible the memory on the board has
been corrupted by a previously loaded application, or the application used a custom baud rate that the
download process does not detect.

To recover from this, it may be necessary to reset the board to factory defaults, as follows:
1. Press and hold the Recovery button (SW1).

2. Pressthe Reset button (SW2).

3. Release the Reset button (SW2).

4. Release the Recovery button (SW1).
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6.3 Incorrect PSoC 6 device names (MPN) in JTAG chain

Some PSoC™ 6 target devices may be displayed with incorrect part numbers in the JTAG chain. This issue
shows only those PSoC™ 6 targets having incorrect value written to JTAG IDCode register.

ModusToolbox™ Programmer - O X

File View Options Help

Programmer MiniProg4 CMSIS-DAP BULK-1D1016CB0008640(

Board  Custom G S% ‘:g § 03

Open Power Disconnect Erase Program Read Verify
Device CYB8C637BZI-MD76

=]

Settings x

Program Settings
File C:/hex/wiced-bt/Hatchet1/mtb-example-threadx-empty-app_download.hex D
Reset Chip
Verify Regions
External Memory

Program Security Data
fogram securty bet Incorrectly detected

Probe Settings device in JTAG chain
nterface ITAG
v JTAG Chain (&

Real physical
target device
2000

3.3
Soft

Log /

Info : JTAG tap: psoch.bs tap/device found: @x2e200068 (mfg: ©@x@34 (Cypress), part: @xe200, ver: @x2) ~
Info : [psoc6.cpu.cm@] Cortex-M@+ r@pl processor defected

Info : [psoc6.cpu.cm@] target has 4 breakpoints,
Tnfo o ook kokokodoiom o i okl R ok kiR R SR KOk KRk R koK
Info : ** Silicon: OxE286, Family: @x18@, Rew/
Info : ** Detected Device: CY8C5247BZI-D54
Info : ** Detected Main Flash size, kb: 1924
Info : ** Flash Boot version: 1.20.1.42

Info : ** Chip Protection: NORMAL

watchpoints

ox23 (B2)

Selected device does not match the physical target device Powered: 3304 mV CY8C6247BZ1-D54

You can ignore this inconsistency in device names if you see the warning "Selected device does not match the
physical target device" after clicking Connect button.
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7 Upgrading firmware

The ModusToolbox™ Programmer application allows you to upgrade KitProg2, KitProg3, and MiniProg4 device
firmware.

7.1 Upgrade KitProg2 firmware
The following upgrade process is based on the CYS8CKIT-062-WIFI-BT hardware.
1. Runthe ModusToolbox™ Programmer application.

2. Go to Options > Programmer Options and select the Show Pop-Up value for the Upgrade Firmware

option.
Programmer Options - ModusToolbox™ Programmer s
Name Value
Upgrade Firmware Show Pop-Up ~
QOpenOCD Telnet Port ‘4445 |
Cancel

3. Click OKto apply the changes.

4. Connect the device with the KitProg2 firmware to the host PC. Ensure that the KitProg2 device is in Native
KP2 mode.

ModusToolbox™ Programmel - [} pad
Programmer | KitProg2-201208B203068400 2
—~
Board ,] ] — »
Open Power  Connect Erase Program Read
Device

5. IfLED2 is off, press the SW3 (Mode Select) button and hold it for about 1 second. When LED2 is on, the
device is ready for upgrading the firmware.

o

" &= CYPRESS

"5 il B
-un
s s

CRLBOTS 1 1 -

CRED
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Awarning dialog displays with the "Firmware is Out of Date" message.

! date.

Warning - ModusToolbox™ Programmer

The firmware of the programming device 'KitProg2-201208B203068400" is out of

To update the firmware, press 'Upgrade Firmware' button or navigate to the
Options menu and choose the 'Upgrade Firmware' option

Upgrade Firmware

6. Click the Upgrade Firmware button to start the upgrade process.

infineon

After the upgrade process completes, the message "Firmware of 'KitProg2-xx' upgraded successfully" displays
in the Log view. The KitProg2-xx programmer disappears from the Programmer drop-down. The Board drop-

down is populated with the names of the supported KitProg3 Kits.

File View Options

ModusToolbox™ Programmer

Help

Programmer | KitProg3 CMSIS-DAP BULK-201208B203068400 ~
Board | CYSCKIT-062-BLE ‘ >
TzEn Custom %
Device ]
Scanned Boards
Settings CY8CKIT-062-BLE
CY8CKIT-062-WiFi-BT
Program Settings CYW943012P6EVE-0T
File Others
Reset Chip CY7110
Verify Regions CY7111
7.2

Follow this process to upgrade KitProg3 on a kit or MiniProg4 firmware:

1. Runthe ModusToolbox™ Programmer application.

Upgrade KitProg3 on kit or MiniProg4 firmware

2. Asneeded, go to Options > Programmer Options and select the Show Pop-Up value for the Upgrade
Firmware option.

3. Connect the KitProg3/MiniProg4 device to the host PC. A warning dialog with the "Firmware is Out of Date"
message displays.

Warning - ModusToolbox™ Programmer

The firmware of the programming device 'KitProg3 CMSIS-DAP
! BULK-201208B203068400 is out of date.

To update the firmware, press 'Upgrade Firmware' button or navigate to the
Options menu and choose the 'Upgrade Firmware' option

Upgrade Firmware

4. Click the Upgrade Firmware button to start the upgrade process.

After the upgrade process completes, the message "Firmware of 'KitProg3-xx' upgraded successfully" or

"Firmware of 'MiniProg4 xx' upgraded successfully" displays in the Log view.

user guide

002-25230 Rev.*J

2024-04-29



ModusToolbox™ Programmer GUI user guide

infineon

Revision history

Revision history

Version Date Description
o 2023-07-18 New document.
Updates for Production milestone:
e Various screen captures
*A 2018-10-30 e
e Description of the Platforms pull-down menu
e Description of the Clock option in Probe Settings
Updated to version 2.1.
e Added Verify Regions menu.
*B 2019-07-19 - .
e Added JTAG Chain instructions.
e Added Verify Custom Flash Regions section.
List of changes:
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R 2023-09-12 e Changed title of the tool and user guide to ModusToolbox™ Programmer.
e Toolis now part of Programming tools package; installation instructions now
included in the release notes.

List of changes:
e Updated to version 5.1.0
e Added section 3.2 - Select device
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IMPORTANT NOTICE

The information given in this document shall in no
event be regarded as a guarantee of conditions or
characteristics ("Beschaffenheitsgarantie") .

With respect to any examples, hints or any typical
values stated herein and/or any information
regarding the application of the product, Infineon
Technologies hereby disclaims any and all
warranties and liabilities of any kind, including
without limitation warranties of non-infringement of
intellectual property rights of any third party.

In addition, any information given in this document
is subject to customer's compliance with its
obligations stated in this document and any
applicable legal requirements, norms and standards
concerning customer's products and any use of the
product of Infineon Technologies in customer's
applications.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer's technical departments
to evaluate the suitability of the product for the
intended application and the completeness of the
product information given in this document with
respect to such application.

For further information on the product, technology.
delivery terms and conditions and prices please
contact your nearest Infineon Technologies office
(www.infineon.com).

WARNINGS

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon
Technologies, Infineon Technologies' products may
not be used in any applications where a failure of the
product or any consequences of the use thereof can
reasonably be expected to result in personal injury.
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